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NOTE
To use the AquaVent with Version
4.2 Levelogger Software, the
AquaVent logger must be using
Firmware Version 1.000 or higher.
The Wellhead must use Firmware
Version 1.000 or higher.

1 Introduction
This user guide explains the capability, operation, and maintenance of the
AquaVent water level and temperature datalogger. Focus is on use with Solinst
Levelogger Software (Solinst Protocol), with separate User Guides discussing use
with SDI-12 and MODBUS protocols.
To begin using your AquaVent, we recommend you install Levelogger Software
Version 4.2 (or higher). Please visit: www.solinst.com/downloads/ to download
the current version or check for updates.
1.1 AquaVent™ Water Level Datalogger
The AquaVent is an accurate water level and temperature datalogger. It uses a
gauged (vented) pressure transducer. The pressure sensor is open to the atmosphere
via a vented cable to surface, therefore, provides water level measurements that
are automatically compensated for barometric effects, as well as temperature.
The AquaVent logger contains a desiccant and hydrophobic filter where the
Vented Cable connects. There is no need to replace the desiccant or filter, they are
designed to provide protection from moisture over the lifetime of the instrument,
while still allowing air to vent to the transducer.
AquaVent Logger Technical Specifications
Level Sensor:

Piezoresistive Silicon with Hastelloy Sensor

Ranges:

5, 10, 20 m (15, 30, 65 ft.)

Accuracy

± 0.05% FS

Normalization:

Automatic Temperature Compensation

Temp. Comp. Range:

0ºC to 50ºC

Temperature Sensor:

Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy:

± 0.05ºC

Temp. Sensor Resolution:

0.003ºC

General:

Figure 1-1 AquaVent Logger

NOTE
The Model number refers to the
depth of submergence below
water level that the pressure sensor
can withstand. i.e.: The AquaVent
which is available in M5, M10, and
M20 ranges has actual water level
ranges of 5 m(16.40 ft), 10 m
(32.80 ft), and 20 m (65.60 ft)
respectively.

Battery Life:

8 Years - based on 1 reading/minute (user replaceable in Wellhead)

Clock Accuracy:

± 1 minute/year (-20ºC to 80ºC)

Operating Temperature:

-20ºC to 80ºC

Maximum # Readings:

40,000 (up to 120,000 using data compression)

Memory:

Built-in FRAM: Continuous or Slate mode

Communication Speed:

9600 bps Solinst USB, 1200 baud SDI-12, MODBUS RS-232/RS-485
(various speeds), data download speed: 57,600 bps

Size:

7/8" x 7" (22 mm x 178 mm)

Weight:

129 grams (4.5 oz.)

Wetted Materials:

Delrin®, Viton®, 316L Stainless Steel

Sampling Modes
(using Levelogger Software):

Linear, Event & User-Selectable Schedule with Repeat Mode,
Future Start, Future Stop, Real Time View

Measurement Rates:

0.125 second to 99 hours

Barometric Compensation:

Automatic

AquaVent Models
M5
M10
M20

Full Scale
5 m (16.4 ft.)
10 m (32.8 ft.)
20 m (65.6 ft.)

Accuracy
± 0.3 cm (0.010 ft.)
± 0.5 cm (0.016 ft)
± 1 cm (0.032 ft.)
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1.2 Measurement Parameters
1.2.1 Level
AquaVent transducers detect both water (W) and barometric pressure (+B).
However, a vent tube to surface allows barometric effects on the pressure sensor
to be eliminated (-B). Therefore, the AquaVent provides readings of the actual
pressure of just water above the pressure sensor zero point (A). This equation
represents how the AquaVent pressure sensor works:
A = (W + +B) + (-B)
Therefore, A=W (See Figure 1-2).
A
W
+B
-B

=
=
=
=

AquaVent readings
Water column height
Barometric pressure detected by the pressor sensor
Barometric pressure applied through the vented cable

A

=

D (depth of AquaVent Zero Point) - d (depth to water measurement)

1.2.1.1 Pressure Calibration

Figure 1-2
AquaVent Measurement Fundamentals

The AquaVent is calibrated against a range of set reference points to an accuracy
of 3 decimal places. During the calibration procedure, the AquaVent logger is
fully submerged in a highly accurate water bath. The bath is set to 6°C and
allowed to stabilize. The pressure is then calibrated to six separate pressure points
covering the entire range of pressure for that particular AquaVent to check for
any non-linearity. The process is repeated again at 18°C and 36ºC to check for
temperature effects. Once done, the AquaVent is approved after all specifications
for accuracy, precision, stability and hysteresis have been met. The AquaVent
should be calibrated for the life-time of the instrument, as long as it is used within
its specified range.
1.2.2 Temperature
The AquaVent records temperature compensated water levels. Groundwater and
surface water temperature measurements are particularly important in situations
where temperatures may fluctuate significantly, and when temperature is used
in determining liquid level, viscosity and hydraulic conductivity. Temperature
monitoring is vital in the calculation of certain temperature dependent contaminant
reaction rates. A Platinum Resistance Temperature Detector is used to accurately
compensate for temperature changes within the range of 0 to +50ºC for the
AquaVent. The AquaVent will record temperature in its thermal range of -20 to
+80ºC, but outside the range, compensation will be less accurate.
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1.3 AquaVent System Components
The AquaVent requires the following components to complete a monitoring
system:
•
•
•
•

AquaVent Logger
AquaVent Communication Wellhead and Connector Cable(s)
Vented Cable
Solinst Levelogger Software
AquaVent SP/SPX Wellhead

NOTE
The Wellhead Connector Cables are
15 ft (4.5 m) in length.
SDI-12 Connector Cable

NOTE
The Wellhead Connector Cables to
be used with the SP Wellhead are
identified with a orange band at
the 10-pin connection. The 10-pin
(Solinst Protocol) connection on the
Wellhead is also labeled orange.

10 Pin
Connections

App/DataGrabber
Connector Cable
MODBUS RS232
Connector Cable

USB Connector Cable

12 Pin
Connections

Vented
Cable
MODBUS RS485
Connector Cable

AquaVent Logger
3001 Levelogger
PC Software

Figure 1-3 Complete AquaVent System

1.3.1 Communication Wellhead and Connector Cables

NOTE
A Levelogger USB PC Interface
Cable can also be used to connect
from an App/DataGrabber
Connector Cable to the USB Port
on a PC. See the Levelogger User
Guide for USB Driver installation
Instructions for the PC Interface
Cable.

The AquaVent Wellhead fits conveniently onto a 2" (50 mm) well casing (a 4"
Adaptor is also available). There are two options: the SP Wellhead has a 10-pin
connection (Solinst Protocol) for cables communicating with Solinst software and
accessories; the SPX Wellhead has an additional 12-pin connection for cables
communicating with third party dataloggers or telemetry systems using MODBUS
or SDI-12 protocols (see separate User Guides).
There are two Connector Cable options for the SP Wellhead:
• The USB Connector Cable connects to a PC for communication with
Levelogger Software.
• App/DataGrabber Connector Cable for connection to a Levelogger
App Interface or DataGrabber. See separate User Guide/Instructions.
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NOTE
The small internal AquaVent logger
battery is only used to maintain
the internal clock of the AquaVent
logger when it is not connected
to the Wellhead, and during any
firmware upgrades.

NOTE
Solinst recommends using 1.5V AA
lithium batteries in the Wellhead.

Each Wellhead comes with four (4) user-replaceable 1.5V AA lithium batteries
that power the AquaVent (see Section 8.1 for battery installation instructions and
battery life estimates). They can last 8 years based on 1 reading per minute.
The Wellheads contain multiple desiccants and have a hydrophobic filter where
the Vented Cable terminates at surface. There is no need to replace desiccants or
the filters, they are designed to provide protection from moisture over the lifetime
of the instrument. The filter protects the cable from moisture, while still allowing
air to flow through the vent tube, resulting in the cancellation effect of barometric
pressure on the AquaVent logger.
A well cap sleeve that fits on 2" well casing comes with each Wellhead; a cable
support hanger bracket is also available to secure the Vented Cable. See section
8.2 for installation instructions.

NOTE
The Wellhead Connector Cables to
be used with the SP Wellhead are
identified with a orange band at
the 10-pin connection. The 10-pin
(Solinst Protocol) connection on the
Wellhead is also labeled orange.

USB Connector Cable

SP Wellhead
App/DataGrabber
Connector Cable
Figure 1-4 SP Wellhead and Connector Cable Options

NOTE
LED definitions for the SPX Wellhead
can be found in separate User
Guides for SDI-12 and MODBUS.

1.3.1.1 SP Wellhead LED Status
The AquaVent Wellheads have a multicolour LED light which indicates the status
and operation of the AquaVent:
Fast Multicolour cycle 3 times: Wellhead is powering-on
Fast 10 cycles alternating blue/green: Wellhead has successfully
connected to the PC using the USB Connector Cable
Fast 10 cycles alternating blue/red: USB connection has been
dropped
Flashing yellow: The Wellhead is communicating with the PC Software
over USB
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NOTE
Before the Vented Cables are
shipped, the vent tubes are blown
dry with nitrogen gas, and capped,
to ensure no moisture during
transport.

1.3.2 Vented Cable
Vented Cables contain power and communication wires, as well as a vent tube
running the length of the cable. Vented Cables provide direct read communication
from the AquaVent logger to the Wellhead. The vent tube and wires are jacketed
in polyurethane, providing durability and protection. The cable is 0.320" (8 mm)
in diameter, while the connectors are 0.860" (22 mm) in diameter.
Vented Cables are custom-built to length. Lengths up to 500 feet are available.

Figure 1-5 AquaVent Vented Cable

1.3.2.1 Vented Cable Connections

NOTE
For diagnostic purposes, you may
wish to install the end of the Vented
Cable with the serial number, to the
Wellhead connection at surface.

NOTE

The Vented Cable ends terminate with female twist connections for the AquaVent
logger and the Wellhead. Therefore, the Vented Cables are interchangeable
(i.e. it does not matter which end is installed on the Wellhead or AquaVent logger).
The steps below show how to connect a Vented Cable to a Wellhead and
AquaVent logger.
Connecting a Vented Cable to the Wellhead

See Section 8.2 for installing the
well cap sleeve and the Support
Hanger Bracket for securing the
cable when deployed.

NOTE
Ensure you save all the storage
caps for future use.

Remove the storage caps from the connectors on the Wellhead and Vented Cable.
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NOTE

Alignment pin in the
Wellhead connector

Alignment socket in the
Vented Cable connectors

For diagnostic purposes, you may
wish to install the end of the Vented
Cable with the serial number, to the
Wellhead connection at surface.

Thumb in line
with pin

Thumb in line
with socket

Line up the alignment socket in the Vented Cable connector with the alignment pin in the
Wellhead connector.

Carefully push the connectors together. Twist the cable connector slightly until you will feel a
small click when the properly aligned connection is made.

NOTE
Do not twist the Vented Cable or
stainless steel cable connector
body when connecting to a
Wellhead or AquaVent logger. Only
twist the stainless steel coupling.

Cable
Connector
Body
Coupling
Tighten the stainless steel coupling while holding the stainless steel cable connector body still.
Tighten the stainless steel coupling until it seats. Do not twist the Vented Cable or Wellhead.
Figure 1-6 Connecting a Vented Cable to the Wellhead
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Connecting a Vented Cable to the AquaVent Logger

NOTE
Ensure you save all the storage
caps for future use.

Remove the storage caps from the connectors on the AquaVent logger and other end of the
Vented Cable.

Line up the alignment pin in the AquaVent logger connector with the alignment socket in the
Vented Cable connector. Carefully push the connectors together. Twist the cable connector
slightly; you will feel a small click when the properly aligned connection is made.
Coupling

NOTE
Do not twist the Vented Cable or
stainless steel cable connector
body when connecting to a
Wellhead or AquaVent logger. Only
twist the stainless steel coupling.

Cable Connector
Body
Tighten the stainless steel coupling while holding the stainless steel cable connector body still.
Tighten the stainless steel coupling until it seats.
Do not twist the Vented Cable or the logger.
Figure 1-7 Connecting a Vented Cable to the AquaVent Logger

NOTE
A Support Hanger Bracket is
available for securing the Vented
Cable in a well or other application.
See Section 8 for deployment tips.

1.3.2.2 Vented Cable Precautions
If the cable needs to bend during installation, ensure the vent tube does not get
kinked inside the cable. Do not allow the vent to become squeezed or flattened
inside the cable. Flattening or a kink in the tube can cause erroneous barometric
compensation. To avoid crimping the vent tube, do not coil the cable tighter
than a 1" (25 mm) radius.
A specially designed Support Hanger Bracket is available from Solinst, for
securing the Vented Cable when deployed. See section 8.2 for instructions to
install the bracket.
During installation, be careful not to nick the cable on a sharp edge. Cutting
through the protective jacket of the cable can cause moisture to access the wiring
inside, which can cause communication issues, or moisture to travel down the
cable.
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NOTE
It is always recommended to use
the most recent version of software
and firmware.
Let Solinst keep you up-to-date with
each new software and firmware
release.
Register your software at:
www.solinst.com/Registration/
to receive these updates
automatically.

2. Solinst Levelogger Software
This Windows based software provides many convenient features. You can
view and program AquaVent settings, begin logging sessions, monitor real-time
readings, download data, manage data files, perform data adjustments, and save
and export data files.
Levelogger Software is used to program all Solinst dataloggers. The software
intuitively detects the type of datalogger connected, and will only display the
setting options specific to that datalogger type.
2.1 System Requirements
The minimal hardware and software requirements for software installation and
operation are:

Hardware
Memory: 32 MB or more

Software
OS: Windows 7, 8 or 10

Display: VGA: 800 x 600 pixels, 256 colour
Ports: USB or RS-232 Serial Port

Communication port setting for AquaVent communications:
Bits per second
Data bits
Stop bits
Flow control

9600 (57,600 data download)
8
1
None
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2.2 Software Installation
Web Download
Download the newest version of Levelogger Software by visiting:
www.solinst.com/downloads/
CD Installation
1. Insert the software CD provided.
2. If the installer does not automatically start, to activate the software install click on
the ‘setup.exe’ file located on the software CD.
3. The Software Installation Wizard will guide you through the remaining installation
process. Figure 2-1 shows the Software Installation Wizard.
4. Restart the computer after installation is completed. Default Directory is:
C:\Program Files\Solinst\Levelogger4_2

Figure 2-1 Found New Hardware Wizard
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2.3 Software Communication
Levelogger Software is Windows based, and is therefore used with a desktop or
laptop PC. The AquaVent communicates to a laptop or desktop PC using a USB
Connector Cable connected to the AquaVent Wellhead. The USB Connector
Cable connects to the 10-pin (Solinst Protocol) connector on a SP or SPX
Wellhead.

Figure 2-2 Communicating with Levelogger Software
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3 Software Startup, Configurations and Settings
3.1 Startup
Plug in the USB Connector Cable before starting the Levelogger Software.

NOTE
Always plug in the USB Connector
Cable before starting the Software.

To start the software, click

, or click the Start button and select:

Programs > Solinst > Levelogger 4 > Levelogger 4.2
Once the program is started, you can set up the parameters for the Software.
3.1.1 Software/Firmware Update Checks

NOTE
Your PC must have an internet
connection to check for software
and firmware updates.
You can also check for updates
using the Help menu.

Each time the software is opened, it automatically checks for software updates. If
there is an update, "Software Update Available" will appear in the top right of the
menu bar. When you click the message, it will open a web page where you can
download the software update.
The Software also checks for firmware updates once you have retrieved settings
from a connected AquaVent (see Section 4). "Firmware Update Available" will
appear in the top right menu bar. Clicking the message will open a web page
where you can download the firmware update. See Section 11 for firmware
update instructions.
3.2 Configuration and Settings
3.2.1 Data Directory
The program will save data downloaded to the following default directory:
<C:\Program Files\Solinst\Levelogger4_2\Data> unless otherwise specified in
the Default Directory field of the Application Settings window (Figure 3-1).
Click the Configuration menu at the top of the program window, select Application
Settings and input or navigate to a different folder destination. After completing
the Application Settings, click the OK button to confirm and save the settings.

Figure 3-1 Application Settings Window
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3.2.2 File Name Settings
From the Application Settings window in the Configuration menu, you can set
what information will be included in your default file names of downloaded data
(see Figure 3-1). You can include Start Date, Stop Date, Serial Number, and
Location. Check-off the information you would like included.
After completing the Application Settings, click the OK button to confirm and
save the settings.
3.2.3 Default File Type
From the Application Settings window in the Configuration menu, you can set
the default file type you would like to use for downloaded, saved and exported
data files. You can select between either *.xle (default) or *.lev file types (see Figure
3-1). For more information about the two file types, see Section 5.1.1.
After completing the Application Settings, click the OK button to confirm and
save the settings.
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NOTE
Click on
icons to get an
explanation of that software
feature.

4 AquaVent Programming
After you start Levelogger Software, the Main Window will appear, with the
Datalogger Settings tab open.

NOTE
After retrieving the settings, If the
Wellhead batteries have drained
to 20% charge or lower, a warning
message will appear to replace the
batteries.

Figure 4-1 Dataloggers Settings Tab

Select the appropriate device from the centre Com Port drop-down menu.
Click

to retrieve the current settings from the connected AquaVent.

4.1 Datalogger Settings

NOTE
The AquaVent which is available
in M5, M10, and M20 ranges has
actual water level ranges of 5 m
(16.40 ft), 10 m (32.80 ft), and
20 m (65.60 ft) respectively.

After you have retrieved the settings of the connected AquaVent, the Datalogger
Settings tab will identify the Instrument Type, Serial Numbers, Firmware Versions,
Project ID, Location, and the Channel Settings.
• Instrument Type: will display the model of the attached
datalogger, i.e.: M5
• Serial Numbers: the unique serial numbers of the attached AquaVent
logger and Wellhead will be displayed.
• Firmware Versions: shows the firmware versions of the connected
AquaVent logger and Wellhead.
• Project ID: input your own identification system. The Project ID is
limited to 32 characters.
• Location: input specific site / location information. The location is
limited to 32 characters.

The MODBUS and SDI-12 Address, and Baud Rate settings are only for use with
the SPX Wellhead. See separate User Guides for communication using MODBUS
and SDI-12 protocols.
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4.1.1 Setting Up Channel Information
In the lower left portion of the Datalogger Settings tab is the area for setting
channel parameters (level, temperature). The software will detect the available
channels when the datalogger settings are retrieved.
4.1.1.1 Level Channel (Ch1)

NOTE
Readings can be converted to other
units using the Data Wizard.

• Identification describes the measurement parameter of the channel
and has already been configured as ‘LEVEL’. The channel can be
re-named to suit each project. The channel monitors water column
equivalent pressure. The Identification field will be the channel heading,
data column heading and graph line name when viewing the data.
Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. There are six
options for water level measurement: m (default), cm, ft, kPa, bar, and
psi.
• Offset refers to an adjustment, such as the distance between
the tip of the AquaVent logger and the monitoring well cap or
static water level. It is recommended that the value of 0.00 be used, as
this keeps all subsequent readings relative to the tip of the logger.
The reference range is -1000 to 16,400 ft or -300 m to 5000 m.

Readings can be corrected or offset
with respect to a specific reference
elevation or datum for a much
wider spectrum of numeric offsets
as part of the Data Wizard.

Figure 4-2 AquaVent Channel Setup

4.1.1.2 Temperature Channel (Ch2)
• Identification describes the measurement parameter of the channel
and has already been configured as 'TEMPERATURE’. The channel
can be re-named to suit each project. The Identification field will be the
channel heading, data column heading and graph line name when
viewing the data. Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. The temperature
channel can be set to °C (default) or ºF.
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4.2 Datalogger Information
The Datalogger Information section shows the Status of the attached AquaVent
(i.e.: Started, Stopped, Future Start) and the Start Time and Stop Time of the
AquaVent. When a Future Start and/or Stop time is set (see Section 4.8), the
Start Time and Stop Time fields will fill in. The fields will update each time the
AquaVent is stopped and started.

Figure 4-3 Datalogger Information

4.3 Datalogger Memory
The Datalogger Memory section shows the amount of memory used, and the
amount of memory remaining (number of readings).

Figure 4-4 Datalogger Memory Remaining

NOTE
To synchronize to a different time/
time zone you first must adjust the
computer time using the Windows
Operating System Date and Time
Settings menu. Then re-start the
Solinst Levelogger Software and
synchronize your dataloggers to the
new time.

If the Data Compression option is selected (see Section 4.5), the amount of free
memory shown is approximated as a visual status bar.
4.4 Datalogger Time
The Datalogger Time section provides the controls for setting the AquaVent
clock. If you want to synchronize the AquaVent’s clock to the computer clock,
click Synchronize to set the time in the AquaVent.
If you start the AquaVent without synchronizing the clock and the time difference
between the AquaVent and the PC is more than 3 seconds, the software will give
you a message asking ‘Do you want to synchronize the logger time to system
time?’. Click Yes to synchronize the clock.

Figure 4-5 Datalogger Time
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4.5 Datalogger Sampling Mode

NOTES
The battery life of the AquaVent
Wellhead is 8-10 Years, based on
1 reading per minute. More rapid
readings will reduce the battery life.
For example, if an AquaVent is setup
in Continuous Mode at a sampling
rate of 1 second, the battery will
be depleted in approximately 3
months.

The Datalogger Sampling Mode section allows you to choose the sampling
measurement type. Options for the AquaVent are Linear, Event Based and
Schedule.
Linear refers to a set time interval between collection of readings. Sample Rate
can be any number from 0.125 seconds to 99 hours for the AquaVent. There is a
data compression option available for the AquaVent. This increases the memory
capacity from 40,000 readings to up to a maximum of 120,000. Check the Data
Compression box to allow data compression.
Data Compression works by only saving data changes in memory. For example,
if you have linear sampling set to record each second, and your water level varies
a little for 60 seconds, the memory will only record incremental values for the
60 seconds. When your data is exported, it will display all 60 intervals with the
corresponding level data.

Figure 4-6 Linear Sampling Setup

NOTES
In Event Based sampling mode,
the AquaVent has a total memory
of 25,000 readings of level and
temperature.
In Event Based sampling mode,
battery consumption is mainly
a function of sampling rate.
Therefore, with a smaller sampling
interval, battery power will be used
up quickly whether readings are
stored or not.

Event Based sample collection is the most memory efficient means of data
collection. In Event mode, the AquaVent will be activated at every defined ‘Sample
Rate’ to check if readings have changed by the selected ‘Change’ from the last
recorded reading.
For the AquaVent, ‘LEVEL’ or ‘TEMPERATURE’ is the selected parameter where
change is monitored. The AquaVent will record a new reading only if the specified
change in the parameter has occurred, at the specific point in time, as defined by
the ‘Sample Rate’.
A default reading will also be stored in the AquaVent memory, every 24 hours
from the last recording, if no ‘Change’ occurs.

Figure 4-7 Event Based Sampling Setup

NOTE
A schedule can be saved and
applied to other AquaVents, by
saving the Settings file
(see Section 4.7).

Schedule Sampling allows you to select a logarithmic style sampling schedule
adapted to the needs of each application.
Schedule Sampling is set by using the plus and minus buttons to add or subtract
line items in the Schedule window. The maximum number of line items in a
schedule is 30, each with its own sampling interval of seconds, minutes or hours
and duration of seconds, minutes, hours, days or weeks. A 'Pause' interval can
also be selected, which stops the AquaVent from recording for the specified
duration.
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Running totals of the number of readings still available, from the total possible,
and the run time to date are shown. If the number of readings selected exceeds
the datalogger’s memory capacity an error message appears.
By checking Repeat, the AquaVent will continue to run through the schedule
until its memory is full, or it is stopped.

Figure 4-8 Schedule sampling Setup

4.6 Datalogger Memory Mode
Datalogger Memory Mode selection will only appear when Linear sampling
mode is selected. When using an AquaVent in Linear Mode, there is a choice of
Continuous Logging (wrap around)
or Slate Logging
.
Compressed Linear, Event Based and Schedule sampling modes can only use
the Slate Mode option.
In Continuous Logging, the new log is started at the end of any previous log and
continues logging, eventually recording over the first logged data. As one of the
download options is to ‘Append Data’, Continuous Logging can be a preferred
choice when logging long-term (see Section 5.1.2).
In Slate Logging, the new log is also started at the end of any previous log, but
will stop recording after 40,000 readings (or up to 120,000 readings), so that
the beginning of the current log will not be written over.

Figure 4-9 Datalogger Memory Mode
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4.7 Saving and Retrieving AquaVent Settings Files
To store settings as defaults, click
. It will store the settings of the AquaVent
into an *.dtf file as a series of defaults. The *.dtf file will save the Project ID,
Location, Sample Mode, Sample Rate, Channel ID, Unit, and Offset.
To retrieve settings from defaults, click
from a selected *.dtf file. This is
particularly useful if programming several dataloggers with similar or identical
settings. Keep in mind that Project ID and Location identification information
will be identical and should be distinguished from logger to logger or monitoring
point to point.

NOTES
If a setting has been changed, it
will be highlighted in yellow as a
reminder before the AquaVent is
started.
If a setting has been entered
incorrectly, it will be highlighted
in red.
Changed settings are applied to the
AquaVent automatically when the
Start icon is selected.

NOTE

4.8 Starting and Stopping the AquaVent
Starting the AquaVent
There are two ways to start logging: Start Now or by programming a Future
Start time.
When starting a new logging session, any data from the previous recording
session will be erased (see Section 5 for downloading data).
To start logging immediately, do not fill in a Future Start time and click,
It should say Start Now below the icon to indicate an immediate start.

.

Any changed settings will automatically be applied to the AquaVent, and it will
start logging. Datalogger Status will change from Stopped to Started.
After the AquaVent is started, and begins collecting readings, the Start icon will
be greyed out, and only the Stop icon and Future Stop settings will be active.

Remember to download any data
from the AquaVent before starting
a new session. When starting a
new logging session, any data from
previous recording sessions will be
erased.
Figure 4-10 Starting the AquaVent Immediately

Check Future Start 'At' to set logging to start at a later date and/or time. This
Start mode is referred to as Future Start in the Status field. Click
to apply
the Future Start time and any changes to the datalogger settings.
When the Future Start time is reached, the AquaVent will start logging and the
Status will change from Future Start to Started.

NOTE
Retrieve the AquaVent settings in
order to refresh the status (i.e. when
the status changes from Future Start
to Started).

Figure 4-11 Future Start Setting
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Stopping the AquaVent
There are two ways to stop logging: Stop Now or at a programmed Future Stop
time for the AquaVent.
To stop the AquaVent immediately when it is logging, click
say Stop Now below the icon).

, (it should

The AquaVent can be stopped at any time before it reaches the maximum
reading capacity. Starting again begins a new recording session and clears
previously stored data readings.

Figure 4-12 Stopping the AquaVent immediately

NOTE
If you have set a Future Stop time,
but wish to stop the datalogger
immediately, uncheck the Future
Stop 'At' box, and the Stop icon
should say Stop Now. Click the icon
to stop logging.

To program a Future Stop time for your AquaVent, check Future Stop 'At' and
fill in the desired stop time. The Future Stop time will be applied to the AquaVent
once
is selected for an immediate or future start.
You can also program a Future Stop time after you have started the AquaVent,
by checking Future Stop 'At' and filling in the desired stop time. Select
to
apply the Future Stop time (it should say Future Stop below the icon).
The Stop Time should be shown in the Datalogger Status section.

Figure 4-13 Future Stop Setting

It is critical to note that when the AquaVent logs data in Slate mode, it means
it will record data until stopped or their memory is full. When the memory fills,
the AquaVent will stop recording. For this reason, it is important to determine,
based on your start time and sampling rate, the date and time at which the
memory will be full and the AquaVent will stop recording. The AquaVent records
in Slate mode if Event, Schedule, or Compressed logging. Standard Linear
mode, however, can be set to Slate or to Continuous logging.
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5 Data Control
(Downloading and Viewing Data using Levelogger Software)
Click the Data Control tab on the Main Window. From the Data Control tab you
can download data from an AquaVent, display data in tabular or graphic format,
and save and export data files.

NOTE
When you click on a data point
in the graph, the corresponding
data point will be highlighted in
the table. You can also highlight a
section of data in the graph.

Figure 5-1 Data Control Tab

Click
to open a *.xle or *.lev file. Multiple files can be opened at the same
time and are available for viewing by clicking the File Name Tab on top of the data
table.
All the AquaVent settings and the channel information effective during data
collection are shown on the top left of the window. The bottom left sections of
the window are used to display information after a data compensation has been
performed, such as offsets or unit conversions (see Section 6).
5.1 Downloading Options and Saving Data Files

NOTE
The default file type is *.xle, unless
changed in the Application Settings
(see Section 3.2.3).

5.1.1 Default File Format
The default file type for Levelogger Software Version 4 and up is *.xle, unless
changed to *.lev in the Application Settings (see Section 3.2.3). Previous
Levelogger Software used *.lev files as the default. The *.xle file type is a *.xml
format, which allows for enhanced functionality. The *.xle files can be exported
as *.xml files, which can be integrated into external database programs.
The *.lev files of previous downloads are compatible with Levelogger Software
Version 4 and up, however, *.xle files are not compatible with previous software
versions. To ensure compatibility, all Levelogger Software versions allow data to
be exported as *.csv files for use in external spreadsheet programs. See Section
5.3 for Export options.
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NOTE
Before downloading data you
must select the Com Port that
the AquaVent is connected to
and retrieve the settings from the
attached datalogger by clicking
in Datalogger Settings tab.

5.1.2 Downloading Data
from the Data Control tab to download data from a connected
Click
AquaVent. There are four options for downloading data. They are: All Data,
Append Download, Partial Download and Recover Previous Log.
If you select All Data, the program will download all the data from the current
logging session of an AquaVent into a *.xle file.
The default directory for saved data is in the ‘Data’ folder:
<C:\Program\Files\Solinst\Levelogger4_2\Data>.
If you select Append Download, the program will append the data in an opened
*.xle file from the AquaVent. The opened *.xle file and the attached AquaVent
should have the same serial number and start time, otherwise an error will occur.

Figure 5-2 Partial Download Window

If you select Partial Download, a Partial Download Selection Window will open.
The window shows the time stamp of the first and last reading in the logging
session. Use the slider to select the time interval you would like data from. Once
you click OK, all the data within that time will be downloaded to a *.xle file.
If you select Recover Previous Log, the software will try to recover the data from
the previous log session and download the data to a *.xle file.
Once the data is downloaded from an AquaVent, it is automatically saved in a
temporary file.
5.1.3 Saving Data
Click

to save the data in a specific *.xle file.

The default directory for saved data is in the ‘Data’ folder:
<C:\Program\Files\Solinst\Levelogger4_2\Data>.

Figure 5-3 File Write Error Message

However, the default directory for saved files can be changed by clicking the
Configuration menu at the top of the program window, selecting ‘Application
Settings’ and inputting or navigating to a different folder destination. If an
error is experienced in saving your first data file such as depicted in Figure
5-3, you may not have file writing privileges to the default directory. In this
case, create and set as the default file save folder, a new data folder within the
My Documents folder and attempt the file save procedure again.
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NOTE
Right click, and drag the mouse to
scan the data graph.

5.2 Graph Manipulation and Zoom Function
To perform the Zoom In function on the graph, click
To perform a Zoom Out function on the graph click
all the zoom functions.

.
. Click

to undo

The Zoom functions can also be used for data selections in the graph.
Click
to open the Graph Option Dialog. The Graph Dialog is shown in
Figure 5-4.

Figure 5-4 Line Option Window

The Line Option is used to adjust the style and colour of the line in the graph for
each channel. The user can also select the shape of the data marker or remove
the data marker.

Figure 5-5 Title and Axis Option window

The Title and Axis Option is used to enter the title of the graph and change the
Y axis label or user selected scale. Check the Best Fit box to enable the software
to determine the best fit scale. If the Best Fit box is not checked, the user has
to enter a maximum and minimum value of the selected channel. The X axis is
logging time.
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There is the option to show Combined Plot graphs or Separated Plot graphs of
the data. Choosing a Combined Plot will show the data from each of the channels
in one graph. The Separated Plot option will show a separate graph for each data
channel.

Figure 5-6 Combined and Separated Plot Graphs

There is also the option to view more than one graph at a time. Click and drag a
File Name Tab and drop it when you see a shaded area on the window to open a
separate graph of that data file. You can view any number of graphs at one time
by re-sizing your window as required.

Figure 5-7 Viewing Two Graphs
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5.3 File Export and Print Function
Data can be exported in *.csv (comma separated value) file format or *.xml
(extensible markup language) file format by clicking File > Export > Data or
The *.csv and *.xml file formats are supported and can be imported by most
spreadsheet and database programs.
Also, the data graph can be exported to a *.bmp file or a *.png file by clicking File
> Export > Graph.
The Datalogger Settings, data table and data graph can be printed. Click File >
Print Preview, to open the Print Preview window. Figure 5-9 shows the print
preview of the Datalogger Settings. The Datalogger Settings are always on the
first page of the document. The data graph is on the second page of the document
and the rest of the document is the data table.
Click Print..., to open the print dialog. You can choose to print the entire document
or just a selection. You can also click File > Print, to open the print dialog.

Figure 5-8 Print Preview Screen
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NOTE
Multiple AquaVent files can be
compensated at once.

6 Data Compensation
Data Compensations, such as Manual Data Adjustments and Parameter
Adjustments can be performed automatically using the software Data Wizard, or
manually, by exporting data to an external spreadsheet program.
6.1 Data Wizard
Open the Data Wizard tab. The first step is to select your Data Compensation
Path. The AquaVent will only have the Advanced option available.
The Advanced option allows you to perform Manual Data Adjustments and
Parameter Adjustments.

NOTE
Manual Data Adjustment, and
Parameter Adjustments are useful
for correcting AquaVent data files
to make data consistent across a
project.

Figure 6-1 Data Wizard

Manual Data Adjustment allows you to enter a manual water level measurement
or reference point as a field zero, which all AquaVent water level readings can
then be adjusted to. There is the option to convert readings to Depth to Water
Level measurements (e.g. from the top of a well casing to water level), or Elevation
of Water Level measurements (e.g. above sea level).
Parameter Adjustments allow you to change AquaVent data to different units of
measurements, add an offset, or adjust density.
• Unit conversion allows you to convert level readings in a AquaVent
file to different units (m, cm, ft, kPa, bar or psi), or temperature
readings to ºC or ºF,
• Offset allows you to enter any value, positive or negative, which will
be added to each reading in the selected AquaVent file to be offset by
that amount. It is recommended to stay with the default zero value,
unless a known offset has been determined (e.g. to correct for
pressure sensor drift. See Solinst Technical Bulletin: Understanding
Pressure Sensor Drift).
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• Density Adjustment corrects the range of the level channel in the
AquaVent data file based on a user input adjustment of fluid density.
The range of the density adjustment is from 0.9 kg/L to 1.1 kg/L.

When you select Advanced compensation, the Data Compensation Options
window will open.

Figure 6-2 Data Compensation Options

First, you will select how you want your data displayed (Manual Data Adjustment):
• Depth to Water Level adjusts water level data to represent depth to
water level readings (from the top of a well casing or other
reference point) by entering a field zero, such as a manual depth to
water level measurement. Adjustments can be made to one or more
data files.
• Elevation of Water Level adjusts water level data to represent
elevation of water level readings (above sea level or other reference
point) by entering a measuring point elevation, and a field zero,
such as a staff gauge measurement from that point. Adjustments can
be made to one or more data files.
• Parameter Adjustments Only allows you to adjust one or more data
files to different units, density, etc., while keeping the sensor
diaphragm (zero point) as the reference point for AquaVent.
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Next, you will select Yes or No to performing any Parameter Adjustments on
the data files (will not be active if you selected Parameter Adjustments Only).
Click Next, after you have selected all of your Data Compensation options.
In the next window, you will choose the AquaVent file(s) you would like to use in
the compensation. Any files you have open in the Data Control tab will be listed.
to open any other data
Use the directory on the left of the window or click
files you would like to compensate. Ensure the files you want to compensate are
highlighted in the list. Do this by clicking the file name. To de-select a file, click
again. Select Next to continue.

Figure 6-3 Selecting Files for Compensation

NOTE
When adjusting Units, if you select
apply to all, the same unit change
will be applied to all of the files
being compensated at that time.

If you have selected yes to Parameter Adjustments, or selected the Parameter
Adjustments Only option, in the next window you will enter these. If you did not
select to change any parameters, this window will not be shown.

Figure 6-4 Parameter Adjustments
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NOTE
The date and time of measurement
of the Field Zero must be recorded
to complete the adjustment. The
Field Zero must replace an actual
reading the AquaVent file. I.e. take a
manual measurement immediately
after starting the AquaVent, and
note that time.

Next, for each selected AquaVent file, you will enter the Field Zero(s) you would
like to use to manually adjust your AquaVent data. (If you have selected Parameter
Adjustments Only, this window will not be shown.)
For Depth to Water Level adjustments, enter a Field Zero (A). If the static water
level is below your Field Zero measurement, the Field Zero is input as a positive
value (e.g. a manual water level meter measurement taken from the top of a well
casing. See Example 6.1). If the static water level is above your Field Zero, the
Field Zero is input as a negative value (such as in an artesian condition).
The Time the Field Zero measurement was taken must replace an actual reading
in the AquaVent file. This is selected from the drop-down menu showing all time
stamps in the AquaVent file. Click ‘Add’ to apply the adjustment. If you need to
change a Field Zero, click ‘Update’ after any edits.

Figure 6-5 Manual Data Adjustment - Depth to Water Level
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Example 6.1 Depth to Water Level Adjustment
When using a manual depth to water measurement taken from the top of a
well casing as a Field Zero, enter it as a positive value (e.g. 10 m).
In your adjusted data file, your readings will increase in value as the water
level decreases. This is because the depth to static water level from the top
of the well casing is increasing. The adjusted readings will decrease in value
as the static water level rises.
Original AquaVent Data
(height of water above sensor)
Adjusted AquaVent Data
(depth to water)

8.75 m

8.50 m

8.75 m

9.5 m

9.75 m

(A) 10.0 m

10.25 m

10.0 m

9.25 m

9.0 m
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For Elevation of Water Level adjustments, enter a Measuring Point Elevation
(A) and a Field Zero (B) from that Measuring Point.
If the static water level is below your Measuring Point, the Field Zero is input as
a positive value (e.g. if you are using a manual depth to water measurement as a
Field Zero, from the top of a well casing as the Measuring Point).
If the static water level is above your Measuring Point, the Field Zero is input as a
negative value (such as an artesian condition). The Measuring Point elevation may
also be entered as a negative value.

Figure 6-6 Manual Data Adjustment - Elevation of Water

NOTE
The date and time of measurement
of the Field Zero must be recorded
to complete the adjustment. The
Field Zero must replace an actual
reading the AquaVent file, i.e. take a
manual measurement immediately
after starting the AquaVent, and
note that time.

The Time the Field Zero measurement was taken, must replace an actual reading
in the AquaVent file, and is selected from the drop-down menu showing all time
stamps in the AquaVent file. Click ‘Add’ to apply the adjustment. If you need to
change a Field Zero, click ‘Update’ after any edits.
You can make multiple adjustments to one data file by selecting ‘Add’ again to
enter another Field Zero. All readings after this Time, will be adjusted to this
second measurement. You can add as many adjustments to one AquaVent data
file as you would like (as long as it doesn't exceed the total number of readings in
that file).
Select Next to complete the compensation.
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NOTE
All data files are saved to the default
location: <C:\Program Files\Solinst\
Levelogger4_2\Data>. However,
the default directory for saved files
can be changed by clicking the
Configuration menu at the top of
the program window, selecting
‘Application Settings’ and inputting
or navigating to a different folder
destination.

The compensated data will automatically be saved in a new *.xle file. The
default file name will be the <original AquaVent file name> with the word
<compensated> added to the file name prefix. Alternatively, the user can
rename the compensated file by saving it in the Data Control tab. Do not
change or delete the file extension. All data files are saved to the default location:
<C:\Program Files\Solinst\Levelogger4_2\Data>.
The next window will show the results of the compensation. If the compensation
was unsuccessful, there will be an explanation in the Reason column. You can
still view the compensated file in the Data Control tab, by clicking ‘Open’ in
the Action column. If the compensation is successful, select ‘Open’, to view the
compensated data file in the Data Control tab.

Figure 6-7 Data Compensation Results
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From the Data Control tab, you can view the data, save the compensated file with
a new filename and/or export the data (see Section 5).
All the original AquaVent settings and the channel information effective during
data collection are shown on the top left of the window. The bottom left sections
of the window are used to display the compensation information.

Figure 6-8 Viewing Compensated Files in the Data Control Tab
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NOTE
Datalogger settings can not be
changed in the Real Time tab.
Changes must be made in the
Datalogger Settings tab. The
changes are applied when the
Real Time readings are started.

7 Real Time View
Click the Real Time View tab from the Main Window (Figure 7-1). The purpose
of this tab is to provide on-screen measurement as data is being recorded by the
connected AquaVent. The data is displayed in tabular and graphical format. All
the channel information and AquaVent settings are displayed on the left of the
window.
First, select a non-logged view rate
. This rate can be set
independently of the logging period of the AquaVent and does not interfere with
any logging taking place in the AquaVent itself.
Checking, Enable Manual Data Adjustment, allows you to enter a datum/ field
zero (e.g. depth to water level) to which the change in Real Time View level
measurements are then adjusted against. This is only available when you are
taking readings in m, cm, or ft.
Real Time View readings can be displayed as a graph or in tabular format. The
same graphing options as the Data Control tab are available for Real Time View
readings. Real Time View readings are being recorded within the Levelogger
Software and prior to closing the window, they can be saved by exporting the
.
data into a *.csv file, by choosing the file export option
To start the current readings, click
immediately.

. The readings will be displayed

To take a reading at any specific time, click the
button and that reading will
be added to the displayed data. To turn the Real Time View monitoring off,
decide if you want to save the data as described above, and simply click
.

Figure 7-1 Real Time View Window
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8 Installing the AquaVent
The AquaVent system is designed to be conveniently installed on a 2" well casing
(4" with an adaptor). However, other installations are acceptable, if proper
precautions and recommendations are followed.
The AquaVent Wellheads have a rating of IP 64 (dust and splash resistant), so should
not be submerged at anytime. They can be secured inside an enclosure, however,
it must be vented to equalize atmospheric pressure. The Wellhead measures
ø 4.0" x 5.5" (102 mm x 140 mm).
Begin by ensuring you have correctly connected your AquaVent logger to the
Vented Cable, and the Vented Cable to the Wellhead. See Section 1.3.2.1 for
connection instructions. See Section 8.2 for installation using the well cap sleeve
and the Support Hanger Bracket.
8.1 Installing Wellhead Batteries

NOTE
After retrieving the settings
in Levelogger Software, If the
Wellhead batteries have drained
to 20% charge or lower, a warning
message will appear to replace the
batteries.

NOTE
After replacing the batteries, to
reset the battery indicator in the
Levelogger Software, use the
Diagnostic Utility (see Section
10.6).

Each Wellhead uses four (4) 1.5V AA replaceable lithium batteries. To install the
batteries, follow the steps below:
1. Unscrew the top of the Wellhead to access the battery compartment.
2. Carefully remove the battery holder from the compartment.
3. Install the four batteries in the holder. Ensure proper polarity when placing the
batteries, paying attention to the positive {+} and negative {-} symbols etched in
the holder.
4. Slide the battery holder back into the compartment. Ensure proper alignment; the
spring contacts in the housing should be lined up with the protruding contacts on
the bottom of the battery holder.
5. Screw the top cap firmly back onto the Wellhead.
6. After replacing the batteries, to reset the battery indicator in the Levelogger
Software, use the Diagnostic Utility (see Section 10.6).

Figure 8-1 Installing Wellhead Batteries

8.1.1 Wellhead Battery Life Estimates
AquaVent Sampling Rate

Battery Life Estimate

8 readings per second

10 days

1 reading per second

3 months

1 reading per minute

8 years
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8.2 Vented Cable Support Hanger Bracket
An optional Support Hanger Bracket is available to secure the Vented Cable to
the Wellhead when deployed.
The support system consists of the 2" well cap sleeve (which comes with the
Wellhead) and the Support Hanger Bracket. To accommodate 4" wells, an
adaptor is available for use with the 2" well cap sleeve.
The steps below show how to install the Support Hanger Bracket:

NOTE
There are three holes in the top of
the Support Hanger Bracket that
can be used to secure it in the well
cap sleeve with screws.

NOTE

Insert the Hanger Bracket through the top of the well cap sleeve so it
seats on the shoulder in the sleeve.

Ensure you save the storage caps
supplied on each end of the Vented
Cable for future use.

NOTE

Bring the Vented Cable through the bottom of the well cap sleeve.

For diagnostic purposes, you may
wish to install the end of the Vented
Cable with the serial number, to the
Wellhead connection at surface.

Connect the Vented Cable to the Wellhead. See section 1.3.2.1 for more details.
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Slide the well cap sleeve up to the Wellhead and twist the well cap sleeve into the
Wellhead until it seats.

Wrap the cable around the Hanger Bracket and insert into the cutouts to
secure the cable to the bracket.

NOTE
The holes in the hanger bracket can
accommodate twist ties or zip ties
to secure the cable to the bracket
if desired.

Figure 8-2 Installing AquaVent Support Hanger Bracket
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8.3 AquaVent Orientation
It is recommended that the AquaVent sensor logger be installed in a vertical
orientation. However, inclined or horizontal installation is acceptable.
The pressure sensor measurement line is indicated by the machined line around
the AquaVent logger body, just above the pressure access holes (Figure 8-3).

Figure 8-3
AquaVent Measurement Line

The pressure transducer is oriented in a plane normal to the long axis of the
body, and detects pressure directed along the plane of the long axis. In vertical
orientations, the sensor detects pressure above the pressure transducer line. In
non-vertical orientations, the pressure zero point is proportional to the angle of
inclination.
8.4 AquaVent Installation Depth
Properly estimate the minimum and maximum water levels expected during the
monitoring period. As it measures height of water above the sensor, the AquaVent
needs to be installed so it remains submerged at all times. However, the AquaVent
should not be installed deep enough to touch the bottom of a well or channel
(avoid submergence in sediments).
Maximum submergence depth must also remain within its specified range
throughout the monitoring period. The pressure transducer can be damaged, if
the AquaVent is over-pressurized by submerging it below its intended range. The
AquaVent is warranted up to 200% of their full scale range, however, accuracy
can not be guaranteed beyond full scale.
8.5 Installation Precautions
Carefully lower the AquaVent into water. The impact of suddenly dropping the
AquaVent into water could permanently damage the transducer. Care should be
taken to avoid dropping the AquaVent against a hard surface.
Other important considerations when installing the AquaVent in pressurized or
intermittently pressurized locations such as pressure vessels, pressurized pipes,
pulse flow conditions, drop structures or near hydraulics works, is to keep in mind
the potential effect of water or steam hammer and hydraulic jump.
Water hammer is caused by an abrupt alteration of flow direction resulting in
pressure surges. Steam hammer occurs when steam enters a cold pipe partially
filled with water. The hammer effect has the potential to significantly increase
hydraulic pressure possibly exposing the pressure sensor to pressures beyond its
maximum rating.
Hydraulic jump is a phenomenon that occurs when water is ‘lifted’ or ‘ramped’
by velocity or flow obstructions. Hydraulic jump causes turbulence and creates
non-representative head conditions in the water column. Care should be taken to
avoid installation at points susceptible to hydraulic jump.
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8.6 Installation in Extreme Environments
8.6.1 Freezing or High Temperature Conditions

NOTE
Although precautions can be taken,
placing an AquaVent in a situation
where the water may freeze solid
can permanently damage the
sensor.

AquaVent installation in locations that may be at risk of freezing, is not
recommended without taking precautions. When water freezes it expands
approximately 9% by volume. A 9% expansion can equate to extreme pressure.
Therefore, solid freezing has the potential to damage the pressure transducer,
which is rated to withstand up to 200% of its depth fluctuation range. As such,
care should be taken when choosing the appropriate pressure transducer range
for your application.
If monitoring shallow water bodies or groundwater zones susceptible to freezing,
the easiest way to avoid transducer damage is to lower the transducer to a point
in the water column below the frost line or ice formation depth. In water bodies
such as shallow streams, wetlands or ponds where freezing may penetrate to the
bottom, install the AquaVent in a vented stilling well imbedded into the bottom of
the water body beyond the frost line.
In cases where the above noted precautions cannot be taken and the AquaVent
must be installed in the freezing zone, it is recommended that the AquaVent be
placed inside a thick membrane balloon filled with a non-toxic, non- corrosive
anti-freeze solution and sealed. Place the balloon in a section of perforated, 1.25"
(30 mm) ID pipe and install the AquaVent in the monitored water. The antifreeze
solution will protect the AquaVent from ice expansion at the pressure transducer,
yet transmit any pressure and temperature fluctuations that occur. However, it
should be noted that even if these precautions are taken, there is still the risk
that placing an AquaVent in a situation where the water may freeze solid can
permanently damage the sensor.
Please note that a similar installation protection can be used when the AquaVent
is monitoring liquids which are incompatible with its wetted materials.
The operating temperature range for the AquaVent is -20° to 80°C (-4° to 180°F).
At the opposite end of the thermal scale, exposing the AquaVent to temperatures
beyond 80°C may damage the thermistor and otherwise affect the AquaVent.
8.6.2 Marine or Brackish Installations
When installing the AquaVent in salt or brackish water or in a liquid having
a specific gravity (density) different than fresh water, the density difference is
compensated for by inputting the density of the monitored fluid in the Data
Wizard (see Section 6.)
The AquaVent can be used for monitoring in salt or brackish water. However, long
term use of the stainless steel body in salt or brackish water is not recommended,
as the salt or other pollutants may cause pitting which can lead to perforation of
the AquaVent’s casing. To minimize this effect, regularly lift the AquaVent from
the liquid; within seconds a thin protective layer will be formed by oxidation.
If using an AquaVent in a continuous salt/brackish monitoring scenario, the
stainless steel body of the logger can be protected in a manner similar to the
freezing protection method described in Section 8.6.1. The AquaVent can be
placed in a thick membrane balloon filled with non-corrosive/ non-toxic fluid,
such as tap water. As pressure changes, the fluid encasing the AquaVent will
transmit the pressure differential to the pressure transducer.
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8.6.3 Biofouling Conditions

1.65"
(42 mm)

Biofouling is the unwanted buildup of microorganisms, plants, algae, or organisms
such as barnacles and muscles on a wetted surface. When a AquaVent is deployed
for an extended period of time, especially in a saltwater environment, there is
the risk of biofouling. Biofouling on the pressure sensor can compromise the
accuracy of the measurements.
4 1/8"
(105 mm)

A Solinst Biofoul Screen can be used to protect the AquaVent from biofouling.
The copper-coiled Delrin screen naturally reduces biofouling, and lengthens the
time a AquaVent can be deployed before maintenance is required. The Biofoul
Screen simply slips onto the sensor end of the AquaVent logger where it is held
in place with its compression fitting. It adds about 3/4" (19 mm) to the length of
the AquaVent logger. It allows water to freely enter the pressure transducer inlets.
It is replaced as required.

Figure 8-4 Biofoul Screen Dimensions

Figure 8-5 Solinst Biofoul Screen
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9 AquaVent Maintenance
As with any groundwater or surface water monitoring project, you should select
the proper equipment and determine a maintenance schedule based on the
monitoring environment specific to your application.
For the AquaVent, this means selecting the appropriate pressure range, ensuring
the monitoring temperatures are within the instruments specifications, and
making sure the wetted materials are compatible with site chemistry.
9.1 AquaVent Logger Maintenance
AquaVent logger maintenance consists of cleaning the outside casing and the
circulation holes. The required frequency of cleaning is dependent on several
aspects of the monitored water quality. In freshwater with good to excellent water
quality, the AquaVent cleaning requirements will be very minimal; amounting to
a seasonal or even annual maintenance inspection.
In most cases cleaning can be accomplished by rinsing the AquaVent and using
mild, non-residual, non-abrasive household cleaners with a very soft-plastic,
bristled, pipe-cleaner type brush. Do not insert any object through the circulation
holes at the sensor end of the AquaVent.
In some cases simple cleaners are insufficient to properly clean the AquaVent.
Several commonly occurring water conditions require specific maintenance
methods. These include hard water, high suspended solids loading, biological or
chemical fouling and salt or brackish water conditions.
Hard water monitoring can result in the precipitation of calcium and magnesium
deposits on the pressure transducer as well as other components of the AquaVent.
These deposits can be safely dissolved using a diluted solution (typically ≤ 10%
strength) of acetic or phosphoric acid. Commercially available products for
dissolving hard water scaling are also available and can be used if designed for
household use. Some industrial strength hard water scaling removers are much
higher strength and are not recommended for cleaning the AquaVent.
High suspended solids load may block the circulation ports or clog the internal
pressure cell of the AquaVent. The potential clogging effect of solids deposition
can be minimized by placing the AquaVent in zones of flow. To remove solids
build up, rinse the AquaVent under a low flow of tap water until particles have
been washed away.
Bacteriological or chemical fouling can be an important consideration in many
ground and surface water monitoring projects. Sessile bacteria will often utilize
installed instrumentation as an attachment substrate. Chemical deposit can be the
result of electrical charge differential between the instrumentation of the monitored
liquid or the result of biological or algal activity. Both forms of fouling can result
in difficult to remove deposits on the AquaVent transducer, the conductivity wires
and the AquaVent casing. To remove fouling use a diluted (≤10%) solution of
sulfuric acid. Persistent material may require soaking for several hours.
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Replacing the o-ring should be done on a regular basis. The o-ring ensures a
tight seal at the Vented Cable connection, which is important for keeping moisture
out. Replacement O-rings are available in sets of ten from Solinst.
O-Ring

Figure 9-1 O-Ring at the Vented Cable Connection

Proper storage when not in use is important. The AquaVent should be stored
with the protective cap threaded onto the Vented Cable connector. The hard
case that the AquaVent logger was received in, should also be used to protect the
logger during storage.

Figure 9-2 AquaVent Logger with Storage Cap and Protective Case

NOTE
Before the Vented Cables are
shipped, the vent tubes are blown
dry with nitrogen gas, and capped,
to ensure no moisture during
transport. These caps should be
retained.

9.2 Vented Cable Maintenance
Proper storage of the Vented Cable is very important. The Vented Cables are
shipped with the ends capped; these caps should be retained, and used to seal
the Vented Cable connections when not in use and during periods of storage. It
is also recommended the Vented Cable be stored on the spool it was received on
(for longer lengths). This protects the Cable and avoids the vent tube from being
kinked.
To ensure the vent tube is dry before deployment or storage, Solinst offers a
special fitting that allows you to blow nitrogen gas through the tube. See Section
9.2.1.
Cleaning the connections ensures a proper seal. A cotton swab can be used to
clear any moisture or debris from the connectors.

Storage
Cap

Storage
Spool

Figure 9-3 Vented Cable Maintenance
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9.2.1 Vented Cable Blowout Fitting
Using the Vented Cable Blowout Fitting to dry the vent tube is recommended
before starting any new project or before storing the Vented Cable.
Vented Cable
Connection

Nitrogen Gas
Tank Hose Fitting
Connection
Figure 9-4 Vented Cable Blowout Fitting

To use the Vented Cable Blowout Fitting:

NOTE
Do not twist the Blowout Fitting,
Vented Cable or stainless steel cable
connector body when connecting
to the fitting. Only twist the
stainless steel coupling.

1. Remove the storage caps from both ends of the Vented Cable (remember to save
the caps). Or if deployed, remove the AquaVent logger and Wellhead.
2. Connect one end of the Vented Cable to the correct connection on the Blowout
Fitting. Ensure proper alignment before pushing the connection together. Twist
the stainless steel coupling onto the Blowout Fitting until it seats. Do not twist
the Vented Cable, cable connector body, or Blowout Fitting.
Cable Connector Body

“M” Style QuickConnect Nipple

Vented Cable
Stainless Steel Coupling
Figure 9-5 Vented Cable Connected to the Blowout Fitting

3. Connect the other end of the Blowout Fitting to the nitrogen gas tank hose fitting.
4. Slowly apply 25-30 psi of nitrogen
gas to the Vented Cable. Let
pressure flow through the cable
for about 5 minutes. If you hear
no air flow, you can apply up
to 50 psi of pressure to clear any
blockages.

NOTE
Do not exceed 50 psi of pressure
when using the Vented Cable
Blowout Fitting.

5. Turn off the nitrogen gas flow and
remove the Vented Cable from
the Blowout Fitting.
6. If deploying the AquaVent,
immediately connect one end of
the Vented Cable to the AquaVent
logger, and the other to the
Wellhead. See Section 1.3.2.1
for connection instructions.
7. If storing the Vented Cable,
immediately install the storage
caps to both ends of the Vented
Cable.
Figure 9-6 Nitrogen Gas Being Blown Through
the Vented Cable
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NOTE
After retrieving the settings
in Levelogger Software, If the
Wellhead batteries have drained
to 20% charge or lower, a warning
message will appear to replace the
batteries.

9.3 AquaVent Wellhead Maintenance
Replacing the batteries will have to be done on a regular basis, and is based
on usage. See Section 8.1 for battery life estimates and installation instructions.
Replacing the o-ring at the Vented Cable connector should also be done
regularly. The o-ring ensures a tight seal at the Vented Cable connection, which
is important for keeping moisture out. Replacement O-rings are available in sets
of ten from Solinst.
When not in use, the Wellhead should be stored with the dust cap on the
Vented Cable Connector. The blue dust caps should also be secured to the cable
connector(s) on the side of the Wellhead.

Dust Cap & O-ring

Dust Cap

Figure 9-7 Wellhead O-ring and Dust Cap at the Vented Cable Connection
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10 Diagnostics Utility
The Levelogger Software Diagnostics Utility can be used for troubleshooting the
AquaVent and obtaining information about that AquaVent, which can assist the
Solinst Technical Support representative to identify and fix any problems you
may encounter. The Diagnostics Utility can be launched from the Utilities menu
at the top of the software. The utility can be used to run a self-test, do a Memory
Dump, create and email reports, and reset the AquaVent battery indicator.
10.1 Run Diagnostics
The Run Diagnostics function reads the following information from the
AquaVent:
1)
2)
3)
4)
5)
6)
7)
8)
9)
10)
11)

Logger and Wellhead Serial Numbers
Model Number
Logger and Wellhead Firmware Versions
Battery Voltage
Charge Level
Current Level Reading
Current Temperature Reading
Max/Min Pressure Reading
Max/Min Temperature Reading
Max/Min Conductivity Reading
Total Number of Logs

This information can be used to identify firmware, battery and/or temperature/
pressure sensor problems. This function also performs a series of self-tests
on the AquaVent to check for problems with the battery, memory, pressure/
temperature sensor. If any of these tests fail then a report should be created and
emailed to Solinst Technical Support. To execute this function simply click the
‘Run Diagnostics’ button.

Figure 10-1 Run Diagnostics
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NOTE
It is recommended that, before
attempting to use this function,
you use the ‘Create Report’ function
to send a report to the Solinst
Technical Support.

10.2 Read Memory Dump
This function creates a complete dump of the AquaVent’s memory, which can
then be sent to Solinst Technical Support for analyzing.
To execute this function simply click the Read Memory Dump button. Performing
a memory dump will create a *.xle file of the data to save.

Figure 10-2 Read Memory Dump

NOTE
The 'Email Report' option
automatically creates a report and
attaches it to an email to send to
Solinst - all in one step.

10.3 Create Report
This function simply creates a text file containing the information obtained
from the Run Diagnostics function. When you click the Create Report button, a
window will pop up asking you to fill out your company information. Simply fill
this out and the resulting report can be saved or sent to Solinst Technical Support
for troubleshooting.

Figure 10-3 Customer Info Input Window
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Figure 10-4 Report Example

10.4 Email Report
Clicking Email Report will guide you through the process of creating a Diagnostics
Report, and it will automatically attach the report to an email to send to Solinst
Technical Staff for troubleshooting.

NOTE
Your Computer must have an
Internet connection to check for
software and firmware updates.
You can also check for updates
using the Help menu.

10.5 Software/Firmware Updates
Each time the Diagnostic Utility is opened, it automatically checks for software
updates. If there is an update, "Software Update Available" will appear in the top
right of the window. When you click the message, a web page will open, allowing
you to download the software update.
The Utility also checks for firmware updates. "Firmware Update Available" will
appear in the top right of the window. Clicking the message will open a web
page where you can download the firmware update. See Section 11 for firmware
update instructions.
10.6 Reset AquaVent Battery Indicator
After replacing the Wellhead batteries, in order to reset the battery indcator in
the Levelogger Software, click the “Run Diagnostics” button, then click “Reset
AquaVent Battery Indicator”.

Figure 10-5 Reset AquaVent Battery Indicator
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NOTE
To check for firmware updates
using Levelogger Software, retrieve
settings from the connected
AquaVent (see Section 4). “Firmware
Update Available” will appear in
the top right menu bar if there is
an update available. Clicking the
message will open a web page
where you can download the
firmware update. You can also use
the Software’s Help menu.

NOTE
It is important that the
communication between the PC
and the AquaVent is not interrupted
during a firmware upload, so
please make sure to close any other
running programs, including screen
savers, and do not disconnect the
AquaVent before the upload is
finished.

NOTE
While the firmware is being
updated, the SPX Wellhead will
ignore or provide time-out response
to any requests from the MODBUS
or SDI-12 network.

NOTE
If an upgrade process in the SPX
Wellhead fails or is interrupted,
then recovery may require a power
cycle, usually accomplished by
unplugging the USB Connector
Cable and SDI-12/MODBUS
Connector Cable, then reconnecting after 30 seconds.

11 Firmware Upgrade Utility
With the AquaVent logger connected to the Wellhead by the Vented Cable, use
the USB Connector Cable to connect the SP or SPX Wellhead to the PC.
The SPX Wellhead also needs a power supply connected to the SDI-12/MODBUS
Connector Cable in order to perform the firmware upgrade. See separate User
Guides for power connection instructions.
The Firmware Upgrade Utility is used to upload new firmware files to an
AquaVent logger and/or SP/SPX Wellhead. The Firmware Upgrade Utility can
be launched from the Utilities menu at the top of the Levelogger Software. The
zipped firmware file can be obtained from: http://www.solinst.com/downloads/
Make sure to unzip the firmware file after you have downloaded it, so you can
access the *.ssf file. There are two separate firmware files available; one for the
AquaVent logger and one for the SP/SPX Wellheads. Update each hardware
component separately; update the Wellhead before updating the AquaVent logger.
To upload new firmware to an AquaVent, follow these steps:
1) Open the Solinst Firmware Upgrade Utility from the Utilities menu in the Main
Levelogger Software Window. Pick the Com Port to which the AquaVent is
connected and make sure the Baud Rate is set to 9600.
2) Click the ‘Open’ button
, which should open a file dialog asking for the
firmware file (*.ssf) to upload. Navigate to the directory where the firmware file
was saved on your PC, then click on the file and click ‘Open’.
3) Check the ‘Firmware File Information’ box to make sure the opened file is correct.
4) Click the ‘Upload Firmware’ button

, to start the firmware upload process.

5) If a communication error occurs and is indicated in the AquaVent Information
Window (Figure 11-1) either before the ‘Verified Program Checksum’ message or
after the ‘Program Information Section’, then restart the upgrade process.
6) If, however, a communication error occurs between the ‘Verified Program
Checksum’ and the ‘Program Information Section’ messages, then please contact
Solinst. You will need to give the AquaVent serial numbers and explain the exact
positioning of the error message.

Figure 11-1 Firmware Upgrade Utility Window

Page 47

AquaVent™ User Guide
12 Troubleshooting
12.1 Problems During Installation of Levelogger Software
‘Class not Registered’ or ‘DLL not found’ or ‘Access violation’
1) You may not have Administrator Rights to install the software in the
Windows 7/8/10 environment.
		

- Ask your System Administrator for assistance.

2) Some files got corrupted during installation of the Levelogger Software. Use
‘Add/Remove Programs’ to uninstall then re-install Levelogger Software.

12.2 Error During Software Uninstall Process
The ‘Add/Remove Program’ cannot locate the Levelogger <setup.exe> file of
the software or the link between the software and the ‘Add/Remove Program’ is
damaged.
The record in the Registry Table must be removed:
1) Ask your System Administrator to remove this.
2) Refer to the following link from Microsoft Website for instructions:
http://support.microsoft.com/default.aspx?scid=kb;en-us;247501

12.3 Data Has Been Erased Accidentally
If AquaVent has been restarted and old data has not been saved, go to Download
Options and choose Data Recovery. It downloads the immediately previous log.
12.4 Error Messages During Use of Software
‘Communication Time Out’ or ‘Communication Error’ or
‘The Command that is sent to the Levelogger Edge is not defined’
1) Try communicating with another AquaVent Logger, Wellhead, Vented Cable or
USB Connector Cable.
2) Clean the Vented Cable connections to the AquaVent logger and Wellhead.
3) Check that the USB Connector Cable is connected to the same Com Port that is
chosen in the upper middle of the Main Window of the Levelogger Software.
4) Check the Com Port settings. They should be as follows:
•
•
•
•
•

Bits per second: 9600
Data bits: 8
Parity: None
Stop bits: 1
Flow control: None
(This may have been set to Xon/Xoff – change it to None, Select [OK]
and back out of this pathway.)
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The route to view your Com Port settings is as follows:
a. Select Control Panels
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Ports
e. Double click on Communications Port(s)
f. Choose the Port Settings Tab
5) Try using a different computer, to see if this is the cause of the problem.
6) If problem persists, contact Solinst.

'Port Cannot Open’
1) Ensure you have plugged the USB Connector Cable into the PC before starting
Levelogger Software.
2) Ensure the correct Com Port is selected in the upper middle of the Main Window
of the Levelogger Software.
3) Check if some other software is using the same Com Port in the background.
Shut that software down or choose another Com Port if available. Such
background software may be anti-virus software or PDA software.
4) Make sure your Com Port has been enabled:
a.
b.
c.
d.
e.
f.
g.

Select Control Panel
Double click on System
Select the Device Manager Tab
Double click on Ports
Double click on Communications Port(s)
Choose General
Uncheck ‘Disable in this hardware profile box’

‘File Create Error’ and ‘File Write Error’
1) If you do not have file-writing privileges to the default data folder,
change the folder as follows: in the Levelogger Software, click ‘Configuration’
then ‘Application Settings’. Under ‘Default Directory’, enter a new destination
folder, to which you have file writing privileges, e.g. ‘My Documents’. Follow the
same procedure if you have the same problem when you export the data file in
csv format.
2) Ask your System Administrator for assistance.

‘File Open Error’ and ‘File Read Error’
1) Shut down or disable any other software that is active and using the same file.
2) In Notepad or Wordpad, open the <*.xle> file to check for corruptions. How are
the AquaVent files ended?
3) If problems persist contact Solinst for assistance.
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‘A different type of Levelogger is detected’
Try clicking the Retrieve Settings icon again, or replace the AquaVent currently
connected, with the one that was previously being worked on, and complete the
operation.
‘Data Corrupted’
Contact Solinst for assistance. Use Levelogger Diagnostic Utility to do a memory
dump and sent the dump file to Solinst for further analysis.
‘Internal Error’
Contact Solinst for assistance.
‘Fail to append data - A different Levelogger has been detected!’ or ‘Fail to
append data - A different start time has been detected!’ or ‘Fail to append
data - New data is not available in the Levelogger!’
The Levelogger Software can only append data to a file that has the same serial
number and start time as the connected AquaVent. Find the correct file, or use
‘All Data’ to download the complete file.
‘Only Levelogger Gold/Edge supports this function’
The ‘Append Data’, ‘Partial Download’ and ‘Data Recovery’ functions are only
supported by the Levelogger Gold/Edge/AquaVent.
‘Schedule cannot be empty’
When using the ‘Schedule’ sampling option in an AquaVent, the schedule must
contain at least one item.
‘Readings in schedule exceed the maximum’
The number of readings in a schedule should not result in more than 40,000
individual readings.
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